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Overview

This section discusses the following topics:
• When to Use the DeviceMaster NS-Link Device Driver
• Comtrol Drivers Management Console
• Supported Operating Systems
• Products Supported
• Conventions on Page 6
• Downloading the Latest Software and User Guides on Page 7

When to Use the DeviceMaster NS-Link Device Driver

Install the DeviceMaster NS-Link device driver to use DeviceMaster serial ports 
as native COM ports and to set up secure COM ports. If you install the device 
driver, you can also configure the ports for socket mode or serial tunneling. See 
NS-Link Device Driver Configuration Considerations on Page 29 for detailed 
information about the NS-Link device driver.

Comtrol Drivers Management Console

This User Guide discusses how to install and configure Comtrol device drivers 
using the Installation Setup Wizard and the Comtrol Drivers Management Console 
for the NS-Link device driver.
The Comtrol Drivers Management Console is accessible through the Windows 
Control Panel using a dedicated shortcut created during the initial device driver 
installation process. The Comtrol Drivers Management Console allows you to 
browse all installed and supported Comtrol products in one place and apply any 
changes quickly.
Note: This User Guide discusses the DeviceMaster, see the RocketPort EXPRESS/

INFINITY, RocketPort and RocketModem (Universal PCI) Series User 
Guide for Windows for adapter specific information.

You can refer to Using the Comtrol Drivers Management Console on Page 31 for 
general information about the Comtrol Drivers Management Console.

Supported Operating Systems

The Comtrol Drivers Management Console supports the following operating 
systems:
• Windows 8
• Windows Server 2012
• Windows 7
• Windows Server 2008
• Windows Vista
DeviceMaster Driver User Guide: 2000531 Rev. E Overview - 5



 Overview 
• Windows Server 2003
• Windows XP

Products Supported

These are the products supported by the Comtrol Drivers Management Console:
• DeviceMaster LT
• DeviceMaster PRO
• DeviceMaster RTS
• DeviceMaster Serial Hub
• DeviceMaster 500
• RocketModem IV
• RocketPort EXPRESS
• RocketPort EXPRESS SMPTE
• RocketPort INFINITY
• RocketPort Plus Universal PCI
• RocketPort Plus/422 Universal PCI
• RocketPort Universal PCI
• RocketPort Universal PCI SMPTE

Conventions

In the remainder of this User Guide, the products are referred to accordingly:
• Comtrol device unless there is model-specific information
• DeviceMaster means the DeviceMaster models listed in the previous 

subsection
• RocketPort means any RocketPort model
• RocketPort EXPRESS/INFINITY means RocketPort EXPRESS, RocketPort 

EXPRESS SMPTE, and RocketPort INFINITY
• RocketPort and RocketModem (Universal PCI) means RocketModem IV, 

RocketPort Universal PCI, RocketPort Plus Universal PCI, RocketPort Plus/
422 Universal PCI, and RocketPort Universal PCI SMPTE

The paths in this Guide to locate DeviceMaster software and documentation point 
to the DeviceMaster RTS paths on the ftp site. All supported DeviceMasters 
(Products Supported) models use the same software and documentation.
6 - Products Supported DeviceMaster Driver User Guide: 2000531 Rev. E
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Downloading the Latest Software and User Guides

You can use the CD or the following table to locate the latest version of the 
software and documentation.

Software Description Document
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ca
ti

on

PortVision DX

Install on a Windows host to 
program the IP address and manage 
your DeviceMaster.
PortVision DX supports: 
• Windows 8

• Windows Server 2012

• Windows 7

• Windows Server 2008

• Windows Vista

• Windows Server 2003

• Windows XP

DeviceMaster 
Installation 
and 
Configuration 
Guide

F
ir

m
w

ar
e

Bootloader

Bootloader is the operating system 
that runs on the DeviceMaster 
hardware during the power on 
phase, which then loads 
SocketServer.
Update the Bootloader on your 
DeviceMaster, if advised by 
Technical Support.

SocketServer

SocketServer is the name of the TCP/
IP socket web page that is integrated 
in the firmware that comes pre-
installed on your DeviceMaster. 
Note: Make sure you upload the 

latest version of SocketServer 
before configuring the device 
driver. 

D
ev

ic
e 

D
ri

ve
r

Windows 8 
Windows Server 2012 
Windows 7 
Windows Server 2008 
Windows Vista 
Windows Server 2003 
Windows XP

Install if you want COM ports 
(native or secure). 
Existing customers may want to 
refer to Existing Installations on 
Page 9. (This Guide)
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Before Installing the Comtrol Drivers 
Management Console

This section provides an overview for the procedures that you may need to perform 
before installing the Comtrol Drivers Management Console for the device driver.
This section contains the following discussions:
• Existing Installations
• Initial Installation Overview on Page 11
• Install the Hardware on Page 11
• Install PortVision DX on Page 11
• Program the IP Address (Network Information) on Page 13
• Uploading SocketServer on Page 16

Existing Installations

Review the information below if you have an existing installation that predates 
these versions:
• NS-Link Driver before V9.02 or SocketServer Before V8.00
• Installations Before v10.xx on Page 10

NS-Link Driver 
before V9.02 or 
SocketServer Before 
V8.00

If you are familiar with the NS-Link device driver, you will be pleasantly surprised 
to find that NS-Link driver configuration is now handled in an easy to use 
Management Console. In addition, if you are comfortable with using the Device 
Manager configuration method, you can still configure the driver without 
changing your installation routine.
Previous to the NS-Link driver v9.02 and SocketServer v8.00, there were two 
versions of firmware that ran on the DeviceMaster, SocketServer and NS-Link.
With the release of v9.02 of the NS-Link driver, SocketServer and NS-Link have 
been incorporated into a single binary (.bin) file.
By default, once loaded, SocketServer shows in both the web page and PortVision 
DX until the NS-Link device driver begins communication with this particular 
DeviceMaster. Once a driver establishes communications, the firmware indicates 
that it is NS-Link. The driver does not need to upload firmware to the 
DeviceMaster or reboot the DeviceMaster.
If SocketServer does not change to NS-Link in the web page and PortVision DX, 
then the NS-Link device driver loaded in the PC/laptop is NOT communicating 
with the DeviceMaster.
Note: Comtrol recommends uploading the latest version of SocketServer before 

configuring the driver.
You can use PortVision DX to determine your SocketServer or NS-Link versions 
(Page 15).
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Installations Before 
v10.xx

When upgrading NS-Link drivers before v10.xx you must remove the existing 
driver and re-install the latest driver.
Note: If you are unsure about the driver version, refer to Checking the Device 

Driver Version on Page 22.
You can use this procedure to upgrade from a 9.xx driver to 10.xx drivers.
1. Optionally, you can save your existing NS-Link device and COM port 

configuration to a configuration file that you can upload to the device and to 
individual ports after installing the 10.xx driver.

2. Remove the existing NS-Link driver.
3. Reboot the system as prompted.
4. If necessary, check the SocketServer version and upload the latest version.
5. If necessary, upload Bootloader to v3.23 or higher. You can use PortVision DX 

to upload the Bootloader. The procedure for uploading Bootloader is the same 
procedure as uploading SocketServer.

6. Install the latest NS-Link driver by executing the 
DeviceMaster_Windows_x.xx.exe file.

7. Associate the MAC address to the DeviceMaster, if required, configure IP 
mode, and configure the device properties or optionally, upload the device 
properties from the configuration file.

8. Configure the port properties or optionally, upload the COM port properties, 
port-by-port. The port properties must uploaded on a port-by-port basis.
10 - Installations Before v10.xx DeviceMaster Driver User Guide: 2000531 Rev. E
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Initial Installation Overview

If you have already performed the following procedures, you can skip to the next 
section, NS-Link Device Driver Installation on Page 17. 
You may also refer to the DeviceMaster Installation and Configuration Guide, 
which provides detailed information about the following procedures:
1. Install the hardware (below).
2. Install PortVision DX (below).
3. Program the network information using PortVision DX (Page 13).
4. Check the SocketServer version and determine whether you need to download 

an updated version (Page 15).
5. If necessary, upload the latest version of SocketServer (Page 16).

Install the Hardware

If you have not done so, install the DeviceMaster:
1. Connect an Ethernet cable between the DeviceMaster and a host PC NIC or to 

the same Ethernet network segment using a standard Ethernet cable. Refer to 
Connectivity Requirements on Page 68 for cabling information.

2. Connect the power supply or cable to the DeviceMaster and apply power.
3. Check the DeviceMaster LEDs to verify that it is ready. Refer to DeviceMaster 

LEDs on Page 70 to determine the LED status.

Install PortVision DX

PortVision DX automatically detects Comtrol Ethernet attached products 
physically attached to the local network segment so that you can configure the 
network address, upload firmware, and manage the following products:
• DeviceMaster family

- DeviceMaster LT
- DeviceMaster PRO
- DeviceMaster RTS
- DeviceMaster Serial Hub
- DeviceMaster UP
- DeviceMaster 500

• IO-Link Master
• RocketLinx
PortVision DX replaces PortVision Plus. PortVision Plus does not support 
operating systems above Windows 7 and SocketServer versions above v9.00 or NS-
Link device driver v10.xx.
PortVision DX may require that you have the latest Microsoft Service pack for 
your operating system:
• Windows 8
• Windows Server 2012
• Windows 7
• Windows Server 2008
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• Windows Vista
• Windows Server 2003 
• Windows XP 
In addition to identifying Comtrol Ethernet attached products, you can use 
PortVision DX to display any third-party switch and hardware that may be 
connected directly to those devices. All non-Comtrol products and unmanaged 
RocketLinx devices are treated as non-intelligent devices and have limited feature 
support. For example, you cannot configure or update firmware on a third-party 
switch.
Use the following procedure to install PortVision DX.
1. Download PortVision DX from ftp://ftp.comtrol.com/dev_mstr/portvision_dx.
2. Execute the PortVision_DX_[version].msi file and follow the Installation 

wizard.
3. Click Launch PortVision DX and Finish in the last installation screen.
4. Click Scan so that PortVision DX 

locates the DeviceMaster.
PortVision DX displays the Comtrol 
Ethernet attached products for 
which you chose to scan. See the 
PortVision DX help system detailed 
information about how to use it to 
tailor your view. 

5. Go to the next discussion to program 
the network information into the 
DeviceMaster.

You can save time if you only scan for 
DeviceMasters.
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Program the IP Address (Network Information)

If you have not done so, program the IP address for your network. The following 
procedure is to program a single DeviceMaster, if you want to program IP 
addresses into multiple DeviceMasters, refer to the PortVision DX help system or 
the DeviceMaster Installation and Configuration Guide.
1. If necessary, start PortVision DX, Start > Programs > Comtrol > PortVision DX > 

PortVision DX.
2. If the DeviceMaster that you want to program is not displayed, click Scan.
3. Right-click the DeviceMaster in the Device Tree or Device List pane for which 

you want to program network information and click Properties.
Note: Optionally, you can double-click the DeviceMaster and PortVision DX 

opens the Properties page.
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4. Optionally, enter a friendly device name in the Device Name list box. The 
default name is Device and the last three pairs of digits from the MAC address.

5. Optionally, enter the DeviceMaster serial number in the event you need to 
contact Comtrol.
Note: The device status from the main screen displays in the Device Status list 

box.
6. Select the appropriate Detection Type for this DeviceMaster.

• REMOTE means that IP communications are used instead of MAC 
communications. This is generally an indication the DeviceMaster is not on 
the local Ethernet segment

• LOCAL means that the MAC communications level is used and the 
DeviceMaster must be on the local segment for MAC mode to be used. An 
IP address is not required but Technical support recommends using an IP 
address.

7. Select the appropriate IP Mode for your installation:
• If you want to disable IP communications on the DeviceMaster, click 

Disable IP. 
• To use the DeviceMaster with DHCP, click DHCP IP, and make sure that 

you provide the MAC address of the device to the network administrator. 
Make sure that the administrator reserves the IP address, subnet mask 
and gateway address of the DeviceMaster in the DHCP server. 

• To program a static IP address, click Static IP and enter the appropriate 
values for your site. 

8. Leave the Bootloader Timeout set to the default 15.
9. Click Apply Changes and Close.
10. Go to the next subsection to check the SocketServer version.
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Check the SocketServer Version

Check the SocketServer version installed on the DeviceMaster against the latest 
SocketServer version on the ftp site.
1. If necessary, start PortVision DX: Start > Programs > Comtrol > PortVision DX > 

PortVision DX.
Note: The SocketServer version displays for the DeviceMaster under the 

Software Version column.

2. Check for the latest SocketServer version.
Note: Although these paths point to the DeviceMaster RTS subdirectory, the 

software (applications, firmware, and drivers) and documentation 
works on the DeviceMaster LT, DeviceMaster PRO and DeviceMaster 
Serial Hub.

FTP subdirectory: ftp://ftp.comtrol.com/dev_mstr/rts/software/socketserver.

3. If necessary, download SocketServer, and then use the next subsection to 
upload SocketServer. If you do not need to upload the latest version of 
SocketServer, you are ready to install the device NS-Link device driver using 
NS-Link Device Driver Installation on Page 17.
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Uploading SocketServer

The NS-Link device driver loads the current firmware but not until the 
DeviceMaster has shown that an old version of the SocketServer (older than 8.00) 
or any firmware other than NS-Link Updater is running. The driver does not 
upload anything unless it first connects to the default application (SocketServer) 
on the DeviceMaster. 
Note: If you are familiar with the NS-Link driver, you may want to review 

information for existing customers.
Optionally, you can upload the appropriate version of SocketServer after running 
the NS-Link device driver Installation Setup Wizard.
Use the following procedure to upload the latest SocketServer version using 
PortVision DX.
1. Start PortVision DX, click: Start > Programs > Comtrol > PortVision DX > 

PortVision DX.
2. Right-click the DeviceMaster or DeviceMasters of which you want to upload 

the latest version of SocketServer and then click Advanced > Upload Firmware.

3. Browse to the location where you downloaded SocketServer, highlight the file, 
and click Open.

4. Click Yes to the Upload Firmware 
popup.

5. Click Yes to the second Upload 
Firmware popup.
You can click Refresh to verify that 
the upload has been successfully 
completed.

If the upload fails, use the PortVision 
DX General tab on the Properties 
screen to change the Bootloader 
Timeout to 45 seconds and then repeat 
Steps 2 through 5. If the upload fails again, use the TFTP procedure in the 
DeviceMaster Installation and Configuration Guide.
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NS-Link Device Driver Installation

This section discusses the following topics:
• Overview of the driver installation procedures
• Installation Setup Wizard on Page 17 for initial installation procedures
• Checking the Device Driver Version on Page 22
• Updating the Driver on Page 23
• Adding a DeviceMaster (Existing Installation) on Page 27

Overview

If there is an NS-Link device driver already installed on your system for the 
DeviceMaster, use the following discussions:
• Existing Installations on Page 9
• Updating the Driver on Page 23 if you want to update the existing driver.
• Adding a DeviceMaster (Existing Installation) on Page 27 to add more 

DeviceMasters to the existing installation.
If you have performed the following procedures, you can skip to Installation Setup 
Wizard to start NS-Link device driver installation. 
You can use Before Installing the Comtrol Drivers Management Console on Page 9 
for procedures for these steps.
1. Install the DeviceMaster. 
2. Install PortVision DX.
3. Program the network information (IP address) using PortVision DX.
4. Upload the appropriate version of SocketServer firmware.

Installation Setup Wizard

You can use the following procedure to install the device driver and the Comtrol 
Drivers Management Console, which is used to configure the driver.
1. Locate the latest driver assembly (.exe) for your product and copy it to a 

location that is available to the host.
• Download the latest device driver for the DeviceMaster.
• The Software and Documentation CD contains all of the files for 

installation, configuration, and troubleshooting. The CD also provides 
download links to the Comtrol ftp site to locate the latest files.

Note: Administrative privileges are required to install device drivers on 
Windows operating systems newer than Windows Server 2003.

Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the device driver. The DeviceMaster 
default port setting is RS-232, except for the DeviceMaster Serial Hub.

Caution
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2. Execute the NS-Link device driver assembly (DeviceMaster_Windows_x.xx.exe) 
and click Next to start the installation.

3. Optionally, enter a different location to install the driver files.

4. Click Install.
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5. Leave the Launch DeviceMaster Driver Installation box checked and click Finish.

If you do not check this box, you can use the shortcut under the Start button at 
Programs > Comtrol > DeviceMaster > DeviceMaster Driver Installation Wizard to 
install the device driver.

6. Click Next to install the driver.
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7. Click Install and Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Select the DeviceMaster model that you want to install.

9. Enter the number of this DeviceMaster model that you want to install and 
click Ok.

10. Repeat Steps 8 and and 9 for each DeviceMaster that you want to install and 
click Next
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11. Click Proceed.

You may see the following popup for each port.

12. Click the Launch Comtrol Drivers Management Console button.
13. Return to the 

Installation wizard and 
click Close to exit the 
wizard.

14. Go to NS-Link Device 
Driver Configuration 
on Page 29 to start NS-
Link device driver 
configuration. 
The device driver 
installation is not 
complete until you have 
associated the MAC 
address to the 
DeviceMaster. 

15. After associating the 
MAC address, go to 
Configuring Device 
Properties on Page 40 
to set up device properties (device name and starting COM port number).

16. Go to Configuring COM Port Properties on Page 43 to configure any necessary 
COM port characteristics.

After driver installation and configuration, connect the serial devices to the ports. 
For information about the DeviceMaster connectors, refer to the DeviceMaster 
Installation and Configuration User Guide (Page 7).
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Checking the Device Driver Version

Use the appropriate procedure for your operating system to check the Comtrol 
device driver version using the Device Manager.
1. Access the Device Manager using the appropriate method for your operating 

system:
Windows 8 and Windows Server 2012:
a. Open Windows Metro Start.
b. Right-click any blank area and select All Apps.
c. Right-click Computer.
d. On the lower left corner, select Properties.
e. Click Device Manager.
Windows 7 and Windows Vista: 
a. Click Start.
b. Right-click Computer.
c. Click Manage

d. Click Device Manager.

Windows Server 2008 R2: 
a. Click Start.
b. Click Control Panel.
c. Change View by at the top to Large icons.
d. Click Device Manager.
Windows Server 2003 and Windows XP (Logged into a domain controller): 
a. Right-click My Computer.
b. Click Manage

c. Click the Device Manager button.
Windows XP: Not logged into a domain controller: 
a. Right-click My Computer.
b. Click Manage.
c. Click Device Manager.

2. Expand the Multi-port serial adapters entry, right-click the Comtrol device 
that you want to configure, and then click Properties.

3. Click the Driver tab to view the NS-Link device driver version.
You can check this driver version against the latest driver for your product.
If necessary, you can update the device driver using the next subsection.
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Updating the Driver

Use the following procedure to update the DeviceMaster NS-Link device driver 
after initial installation.
If you are unsure what driver version is running, see Checking the Device Driver 
Version on Page 22.
Note: Make sure you review Existing Installations on Page 9 before updating the 

device driver.
1. Locate the latest NS-Link device driver assembly (Page 7) and copy it to a 

location that is available to the host.
2. Close any applications that are using serial ports before the NS-Link device 

driver installation.
3. Start the update by executing the .exe file.
4. Click Next to start the Installation Setup Wizard.

5. Optionally, enter a different location to install the latest NS-Link device driver 
files.
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6. Click Install.

7. Leave the Launch DeviceMaster Driver Installation box checked and click Finish.

If you do not check this box, you can use the shortcut under the Start button at: 
Programs > Comtrol > DeviceMaster > DeviceMaster Driver Installation Wizard.
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8. Click Next to update the driver.

9. Click Update and Next.

10. Click Next to update the driver.
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11. Click Proceed.

12. Click the Launch Comtrol Drivers Management Console button to configure the 
ports or device properties.

13. Return to the Installation wizard and click Close.

14. If necessary, go to Configuring COM Port Properties on Page 43 to configure 
the NS-Link COM port properties
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Adding a DeviceMaster (Existing Installation)

Use the following procedure to add aDeviceMaster to an existing DeviceMaster 
installation.
1. Close any applications that are using serial ports before the device driver 

installation.
2. Connect the DeviceMaster to your network and use PortVision DX to program 

the IP address.
If you need hardware installation procedures, see Downloading the Latest 
Software and User Guides on Page 7). 
Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the device driver. The default port setting 
is RS-232.

3. From the Start button, click:
4. Click Next to start the Comtrol Driver Installation Wizard.

5. Click Install and Next.

6. Click Next and follow the Installation Wizard. Refer to Step 8 on Page 20, for 
the remainder of the installation steps if needed.

Caution
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NS-Link Device Driver Configuration

If you programmed an IP address into the DeviceMaster for your network using 
PortVision DX before installing the NS-Link device driver; first associate the MAC 
address to the DeviceMaster and then configure the driver with the IP address 
that you programming into the DeviceMaster using PortVision DX.
This section discusses the following topics:
• NS-Link Device Driver Configuration Considerations
• Using the Comtrol Drivers Management Console on Page 31
• Associating the MAC Address on Page 36
• Using IP Mode and Enabling SSL on Page 38
• Configuring Device Properties on Page 40
• Configuring COM Port Properties on Page 43
• Network Configuration in Comtrol Drivers Management Console on Page 49

- Disabling IP Mode on Page 49
- Changing a Static IP Address on Page 50
- Setting Up DHCP on Page 51

• Configuring DeviceMaster Ports as Sockets on Page 53
• Enabling Secure Data Mode on Page 54

NS-Link Device Driver Configuration Considerations

The following subsections discuss the NS-Link device driver features and topics 
that you may want to review before driver configuration.

IP or MAC 
Addressing Issues

This is an overview of IP and MAC addressing issues that may affect how you 
configure the DeviceMaster with a brief discussion of advantages of each method.
Note: The default IP address for the DeviceMaster is 192.168.250.250.
The IP addressing scheme (IP mode) has the following advantages:
• Uses an IEEE industry standard protocol.
• Allows you to configure systems to use ports on the DeviceMaster that are 

outside of the host system’s local Ethernet segment.
Note: This IP address must be a unique reserved IP address. Do not use an 

address from a dynamic address pool. If necessary, see the system 
administrator for an IP address.

The MAC addressing method (MAC mode) has the following advantages:
• Simplifies implementation and ongoing support by eliminating the address 

administration issues inherent in network protocols. MAC addresses are 
predefined by DeviceMaster and there is no potential for an address conflict at 
setup. 

• It is isolated from foreign LAN segments minimizing potential security issues.
• Maximizes throughput of serial data.
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NS-Link Device 
Driver Features

During initial installation and configuration of the NS-Link device driver, Comtrol 
recommends that you associate the MAC address to the DeviceMaster. If you do 
not do so, you will not be able to use the following device driver features:
• Access the Advanced tab to review PC network or device network interface 

statistics
• Program or change an IP address using through the Network Settings button
• Reboot the DeviceMaster from the Comtrol Drivers Management Console
After associating the MAC address, you can then program the DeviceMaster for IP 
or DHCP usage.
You can refer to IP or MAC Addressing Issues on Page 29 for information about 
MAC addressing and IP addressing issues.

Using the Port 
Sharing Feature

DeviceMaster ports can be shared by installing the NS-Link device driver on 
multiple systems or through socket mode, or combination of both. To do so, install 
the NS-Link driver on each system that you want to permit access to the serial 
ports. You can share the same port with multiple systems (only one system can 
have an open connection to a port at any given time) or you can set up multiple 
systems to share specific ports on the device driver..

Use port sharing to configure redundant PCs or fail-over protection.

Note: Most applications do not release ports, so you may not be able to use port 
sharing across multiple systems with the same port. Also, if using port 
sharing, make sure that two computers do not try to access the same port at 
the same time. Only one computer can control a given port at a given time.

Port System A System B

1 COM5 Not Configured

2 COM6 Not Configured

3 Not Configured COM5

4 Not Configured COM6

DeviceMaster
Port 1 

System A System B

Port 2

COM 5 COM 6

Port 3 Port 4

COM 5 COM 6

Ethernet Hub

Configured for System A Configured for System B 

Example:
To configure two ports for System A and two ports for System B, 

1. When installing the device driver on System A, click “Not Configured” for the 

2. When installing the device driver on System B, click “Not Configured” for the 

Multiple systems can use the same COM port names.

:

you could configure the drivers like this:

    COM port names for Ports 3 and 4.

    COM port names for Ports 1 and 2.
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Using the Comtrol Drivers Management Console

This subsection discusses basic Comtrol Drivers Management Console operations, 
such as:
• Accessing the Comtrol Drivers Management Console
• Displaying All Installed Devices on Page 31
• Expanding the View on Page 32
• How to Configure Device Properties on Page 32
• Customizing the Device Name on Page 33
• Customizing the COM Port Name on Page 33
• How to Configure COM Port Properties on Page 34
• How to Save Changes on Page 35
See Associating the MAC Address on Page 36 to start DeviceMaster configuration 
procedures.

Accessing the 
Comtrol Drivers 
Management 
Console

Accessing the Comtrol Drivers Management Console can be done using one of the 
following methods:
• Windows Control Panel; go to your Control Panel and click on the Comtrol 

Drivers Management Console.
•  Shortcut; located under Start > Program Files > Comtrol > DeviceMaster > 

Comtrol Drivers Management Console.

Displaying All 
Installed Devices

The Comtrol Drivers Management Console opens and displays all products for 
which a device driver was installed. 
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Expanding the View To view a device or devices under a product family, click the + in the Tree View 
pane to open the selected family. 

How to Configure 
Device Properties

This overview discusses changing device properties for a product. Highlight the 
device name of the product that you want to configure in the Tree View pane. Make 
any necessary changes.
• Click Apply to save the changes, which saves the changes and leaves the 

Comtrol Drivers Management Console open.
• Click Ok to save the changes and close the Comtrol Drivers Management 

Console.
• Click Cancel to close the Comtrol Drivers Management Console without saving 

the changes.
If you click a port or device name without saving the changes, the Comtrol Drivers 
Management Console will prompt you to Apply, Ignore, or Cancel the changes.
For more information, see Configuring Device Properties on Page 40. 
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Customizing the 
Device Name

Change the default Device Name on the Device General tab by changing the name 
in the User-Friendly Device Name field and saving the change.

Customizing the 
COM Port Name

Change the default Port Name on the Port Settings General tab by changing the 
name in the User-Friendly Port Name field and saving the change.
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How to Configure 
COM Port 
Properties

To change a port’s properties for a product, highlight the port of the product that 
you want to configure in the Tree View pane. Make any necessary changes:
• Click Apply to save the changes, which saves the changes and leaves the 

Comtrol Drivers Management Console open.
• Click Ok to save the changes and close the Comtrol Drivers Management 

Console.
• Click Cancel to undo the changes and close the Comtrol Drivers Management 

Console.
If you click another port or device name without saving the changes, the Comtrol 
Drivers Management Console will prompt you to Apply, Ignore, or Cancel the 
changes.
For more information, see Configuring COM Port Properties on Page 43.
After saving the port changes, if desired, you can click Apply These Settings to All 
Ports to populate the remaining ports with these NS-Link COM properties. 
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How to Save 
Changes

The Comtrol Drivers Management Console indicates that changes have been made 
on this screen with a red frame that identifies which device’s General tab you are 
editing.
• Clicking the Apply button saves the changes on the tab and leaves the Comtrol 

Drivers Management Console open for further configuration.
• Clicking the Ok button saves the changes on that tab and closes the Comtrol 

Drivers Management Console.
• Clicking the Cancel button cancels the changes on that tab and closes the 

Comtrol Drivers Management Console. 
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Associating the MAC Address

The first step to configuring the NS-Link device driver is to associate the MAC 
address of the DeviceMaster to the device driver.
You can use the method that is appropriate to your installation:
• Same Network Segment (below)
• Different Physical Segment on Page 37
Although you can and should associate a MAC address on a different physical 
segment, the DeviceMaster must be connected to the local network segment or 
directly to a NIC on the host system for the NS-Link driver to operate in MAC 
Mode. 

Same Network 
Segment

The DeviceMaster must be connected to the local network segment or directly to a 
NIC on the host system to operate in MAC mode and in order for PortVision DX to 
detect the MAC address, otherwise you must enter the MAC address manually.
Use the following procedure to associate a MAC address to a DeviceMaster.
1. If necessary, access the Comtrol Drivers Management Console, click Start > 

Control Panel > Comtrol Drivers Management Console.
2. Highlight the Device Name of the DeviceMaster that you want to configure.

3. Select the MAC address from the drop-down list or enter the address from the 
MAC address label on the DeviceMaster.
If the appropriate MAC address is not displayed in the drop-down list, then it 
can be one of the following reasons:
• The DeviceMaster is not on the same network segment
• The DeviceMaster not powered on or connected to the network
• The DeviceMaster wrong model was selected during the driver installation
• Device failure
Note: If you enter the MAC address, make sure that you use the correct format: 

00 C0 4E xx xx xx. A space must separate each pair of digits. The MAC 
address is located on a label on the DeviceMaster.
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If you programmed the IP address using PortVision DX, the IP address 
displays in the IP Mode text box.

4. Click Apply to program the driver with the MAC address of the DeviceMaster.
If you do not Apply the changes before leaving this screen, you will be 
prompted to Apply, Ignore, or Cancel the changes.

5. Optionally, you can click the Advanced tab and verify that the Device Status 
message indicates that the DeviceMaster is active and Ok.

6. You may need to perform some of the following tasks to complete the driver 
configuration process.
• Configure the DeviceMaster for IP Mode, see Using IP Mode and Enabling 

SSL on Page 38
• Configure device properties, see Configuring Device Properties on Page 40.
• Configure COM port properties, see Configuring COM Port Properties on 

Page 43.
• Configure any of the DeviceMaster ports as sockets, see Configuring 

DeviceMaster Ports as Sockets on Page 53.

Different Physical 
Segment

Use the following procedure to associate a MAC address to a DeviceMaster that is 
not on the same physical network segment or not connected directly to the NIC.
1. If necessary, start the Comtrol Drivers Management Console.
2. Highlight the Device Name of the DeviceMaster that you want to configure.
3. Enter the MAC address in the MAC Mode text box.

Note: When you enter the MAC address, make sure that you use the correct 
format: 00 C0 4E xx xx xx. A space must separate each pair of digits.  
 
A MAC address is located on a label on the DeviceMaster or use 
PortVision DX to scan the network, which will display the MAC 
address.

4. Click Apply to program the driver with the MAC address of the DeviceMaster 
or Ok to save the change and close the Comtrol Drivers Management Console.
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If you do not Apply the changes, you will be prompted to Apply, Ignore, or 
Cancel the changes.

5. You may need to perform some of the following tasks to complete the driver 
configuration process.
• You can now configure the DeviceMaster to operate in IP Mode using the 

next subsection.
• Configure device properties, see Configuring Device Properties on Page 40.
• Configure COM port properties, see Configuring COM Port Properties on 

Page 43.
• Configure any of the DeviceMaster ports as sockets, see Configuring 

DeviceMaster Ports as Sockets on Page 53.

Using IP Mode and Enabling SSL

After associating the DeviceMaster with the MAC address you can set the 
DeviceMaster to run in IP Mode. 
1. First associate a MAC address (Page 36) to the DeviceMaster.
2. Highlight the DeviceMaster.
3. If the DeviceMaster is on the same network segment, the driver populates the 

IP Mode text box with the DeviceMaster IP address.
If the DeviceMaster is not on the same network segment, enter the IP address 
of the DeviceMaster in the IP Mode text box.

4. Click the IP Mode radio button.

5. Optionally, click Enable SSL Mode or go to Step 8.
The DeviceMaster must be configured using IP Mode before you can Enable 
SSL Mode. If SSL Mode is enabled, TCP connections that carry data to/from 
the serial ports are encrypted using SSL or TLS security protocols. This 
includes the following:
• TCP connections to the per-serial-port TCP ports (default is 8000, 8001, 

8002, ...) are encrypted using SSL/TLS.
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• TCP connections to TCP port 4606 on which the DeviceMaster implements 
the Comtrol proprietary serial driver protocol are encrypted using SSL/
TLS.

• Since SSL/TLS can not be used for either UDP data streams or for the 
Comtrol proprietary MAC mode Ethernet driver protocol, both UDP and 
MAC mode serial data transport features are disabled.

In addition to encrypting the data streams, it is possible to configure the 
DeviceMaster so that only authorized client applications can connect using 
SSL/TLS.
For this option to function, you must also Enable Secure Data Mode in the NS-
Link web page. 

6. If you are using a server certificate, click the Server Certificate check box and 
enter the name in the Server Certificate text box.
This is the RSA identity certificate that the DeviceMaster uses during SSL/
TLS handshaking to identify itself. It is used most frequently by SSL server 
code in the DeviceMaster when clients open connections to the DeviceMaster's 
secure web server or other secure TCP ports.
If a DeviceMaster serial port configuration is set up to open (as a client) a TCP 
connection to another server device, the DeviceMaster also uses this certificate 
to identify itself as an SSL client, if requested by the server.

7. If you are using a client certificate, click the drop list and browse to the 
appropriate client certificate file.
When configured with a CA certificate, the DeviceMaster requires all SSL/TLS 
clients to present an RSA identity certificate that has been signed by the 
configured CA certificate. As shipped, the DeviceMaster is not configured with 
a CA certificate and all SSL/TLS clients are allowed.
If desired, controlled access to SSL/TLS protected features can be configured 
by uploading a client authentication certificate to the DeviceMaster.
When a CA certificate is uploaded, the DeviceMaster only allows SSL/TLS 
connections from client applications that provide to the DeviceMaster an 
identity certificate that has been signed by the CA certificate that was 
uploaded to the DeviceMaster.
This uploaded CA certificate that is used to validate a client's identity is 
sometimes referred to as a trusted root certificate, a trusted authority 
certificate, or a trusted CA certificate. This CA certificate might be that of a 
trusted commercial certificate authority or it may be a privately generated 
certificate that an organization creates internally to provide a mechanism to 
control access to resources that are protected by the SSL/TLS protocols.
To control access to the DeviceMaster's SSL/TLS protected resources you 
should create your own custom CA certificate and then configure authorized 
client applications with identity certificates signed by the custom CA 
certificate.

8. Click Apply or Ok to save the change and close the Comtrol Drivers 
Management Console

9. You may need to perform some of the following tasks to complete the 
configuration process.
• Configure device properties, see Configuring Device Properties on Page 40.
• Configure COM port properties, see Configuring COM Port Properties on 

Page 43.
• Configure any of the DeviceMaster ports as sockets, see Configuring 

DeviceMaster Ports as Sockets on Page 53.
• Enable Secure Data Mode in the NS-Link web page, see Enabling Secure 

Data Mode on Page 54.
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Configuring Device Properties

Use the following procedure to change device settings on a DeviceMaster.
1. Open Comtrol Drivers Management Console (Accessing the Comtrol Drivers 

Management Console on Page 31).
2. Highlight the DeviceMaster device name that you want to configure.

3. If desired, change the User-Friendly Device Name.
4. Optionally, set a different Keep Alive Timeout (Page 41) period. You can set the 

amount of time in seconds that this DeviceMaster waits until it closes this 
connection and frees all the ports associated with it.
Note: This value may be set to less than 5 seconds, however the DeviceMaster 

may not operate at any value less than 5. A recommended value to begin 
experimentation with is 10.

5. Optionally, set the TCP Timeout Multiplier (Page 42) value.
Note: This value should not be modified unless the network connection to the 

DeviceMaster is very slow, such as, if a satellite uplink connection is 
involved. It is recommended that a value over 3 never be used.

6. Optionally, click a different Scan Rate (ms) (Page 42).
7. Optionally, change the Number of Devices to Load at Once (Page 42).
8. If necessary, click Do NOT Attempt to Load Firmware in Device (Page 42).
9. Optionally, click Verbose Event Log if you want to log additional DeviceMaster 

information into the event log.
10. After making your changes, click Apply if you have additional configuration 

procedures or click Ok if you have completed configuring your Comtrol devices.
Note: If you do not Apply the changes, you will be prompted to Apply, Ignore, or 

Cancel the changes.
The following table provides detailed information about Device General tab options 
for the DeviceMaster.
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Device General Tab Description

Device Name
This is the default name assigned by the driver and it cannot be 
changed. You can use the User-Friendly Device Name field to provide 
custom device names for your installation.

User-Friendly Device Name Use this field to enter a more descriptive name. The name that you 
assign is not saved until you click Apply or OK.

Keep Alive Timeout (seconds) 

Default = 120 seconds

Use this option to set the amount of time in seconds that this 
DeviceMaster waits until it closed this connection and frees all the 
ports associated with it. The Keep Alive feature works in the 
following way.
During normal operation the driver periodically sends a connection 
check to the DeviceMaster, and the DeviceMaster then returns a 
response. There are two timers: one in the driver, and one in the 
DeviceMaster. These timers are reset when a connection check 
signal is received. If a connection is broken, that is, a check is not 
received, the data is stored in the computer and/or the 
DeviceMaster. Depending on the amount of time that has expired 
since the connection was lost, the following happens:
• When the computer loses its connection to the DeviceMaster but 

re-establishes it before the time-out period expires, any data 
transmitted during this period is queued and sent when the 
connection resumes. 

• When the computer loses its connection to the DeviceMaster 
and does not re-establish it before the time-out period expires; 
the driver then purges any pending I/O data for ports on that 
connection and returns all pending, and future I/O commands, 
with the exception of the Close command, to the application with 
an error indicating the disconnected status. 
This is similar to the processing which occurs when the 
computer receives a notification from the DeviceMaster that a 
port release request was processed on a port it owns with the 
exception that a different status is returned. When the 
connection is re-established, the computer will attempt to re-
acquire the ports that were open when the connection was lost. 
If the attempt is successful, normal operations resume for the 
port. If any port fails to be acquired, then the computer will 
continue to fail all further I/O operations, with the exception of a 
Close request. When the Close request is received, the port can 
then be re-opened.

• If the computer loses its connection and the time period expires, 
the DeviceMaster places the port into a state that another 
computer can establish a connection, locking out the original 
driver when a connection is made. The driver will respond to all 
I/O commands, with the exception of the Close command, with 
an error indicating the disconnected status. If the port is still 
available when the driver re-establishes a connection, then it 
will claim the port and allow I/O to resume.
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TCP Timeout Multiplier

Default = 1ms

Use the TCP Timeout Multiplier option to modify two timers used in 
TCP/IP socket communications. 
The first identifies how long the TCP protocol should wait before 
timing out an attempt to open a TCP channel. The TCP Timeout 
Multiplier default is 1 and the timer defaults to 500 ms when the 
TCP/IP address method is used to communicate with a device. 
If the TCP Timeout Multiplier is set to 2, the timer would now be 
1000 ms, or 1 sec. If the multiplier is 4, the new time-out period 
would be 2000 ms, or 2 sec.
The second timer defines how long the driver will wait for a 
response from the DeviceMaster when a forced release of a port is 
requested. This timer defaults to 8 seconds. 
If the TCP Timeout Multiplier is changed to 2, the timer would now 
be 16 seconds. If the multiplier is 4, the new time-out period would 
be 32 seconds.

Scan Rate (ms)]

Default = 10ms

Typically, you should leave the scan rate set to the default value (10 
ms) for most applications. To adjust latency for time-critical 
applications, select a longer or shorter interval from the droplist, or 
type in the rate (2 to 50). If a value larger than 50 is entered, the 
maximum of 50 is implemented. 
Note: The faster the scan rate (lower number), the higher the load 

on the system processor.

Number of Devices to Load at 
Once

Default = 20

This field determines how many DeviceMasters will have firmware 
loaded by the device driver at one time. Increasing the number will 
increase network traffic, decreasing the number will decrease 
network traffic but may increase total load time.

Do NOT Attempt to Load 
Firmware to the Device

Default = Disabled

Click this option if you do not want the device driver firmware to 
upload to the DeviceMaster.
You may want to use this option when custom firmware is loaded as 
the default application. 
The custom firmware must support communications with the device 
driver if you want to access the ports as Windows COM ports.

Verbose Event Log

Default = Disabled

Selecting this option causes detailed messages to be sent to the 
operating system Event Log. This added information can be useful 
when debugging communications and configuration problems

Save Configuration
Click Save Configuration to save the Device Settings for use on 
another similar Comtrol device or to archive a copy of your 
environments settings.

Load Configuration

Click to Load Configuration to load the Device Settings previously 
saved using the Save Configuration feature.
Note: Configuration files must be for the same model with the same 

port density. For example, you cannot load a DeviceMaster 
PRO configuration file onto a DeviceMaster RTS or a 
configuration file for a 32-port DeviceMaster RTS onto a 4-
port  DeviceMaster RTS.

Ok Click Ok to save the changes made on this page and close the 
Comtrol Drivers Management Console.

Cancel Cancels any changes made on this page.

Apply
Click Apply to save the settings on this page. If you do not click 
Apply before leaving this page, you will be prompted to Apply or 
Cancel the changes.

Defaults Resets this screen to its default values.

Device General Tab Description
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Configuring COM Port Properties

This section discusses COM port configuration procedures for DeviceMaster NS-
Link ports. If you want to change the starting NS-Link COM port number on the 
DeviceMaster, see Configuring Device Properties on Page 40.
If your application does not set COM port properties, use the Device Manager to 
access Ports (COM & LPT) to change the port parameters. If the application sets 
COM port properties, those settings take precedence over Windows COM port 
settings. The exception to this guideline is if you use the Override and Lock Baud 
Rate to option.
Use the following procedure to change NS-Link COM port settings on a 
DeviceMaster port or ports.

Do not connect RS-422/485 devices until the appropriate port interface 
type has been configured in the driver. The driver default port setting 
is RS-232.

1. Open Comtrol Drivers Management Console (Page 31).
2. Highlight the appropriate DeviceMaster.
3. Highlight the first port you want to configure.

Caution
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4. Select the appropriate communications mode.
Note: The DeviceMaster Serial Hub only supports RS-232. If you select RS-

422 or RS-485 on the DeviceMaster LT, you may want to configure 
Terminator Resistor options. If so, click the Terminator Resistor Options 
button. 

Make the appropriate selections to reflect your configuration.

5. Enable the features that you require for your environment.
Note: You can use the help system or refer to the following table for 

information about each option.
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6. Optionally, click the RTS Toggle Options button:
• If your communications application does not toggle FTS when transmitting 

in RS-485 mode.
• If you are using an 

external RS-232 to 
RS-485 converter, 
which is attached to 
a port that is 
configured for RS-
232. 

a. Click the 
appropriate options 
for your 
environment.

b. Click OK to save 
the changes and 
return to the port 
General tab.

7. If desired, click the Clone check box to set all of the ports on this Comtrol 
device to these characteristics.

8. Optionally, change the User-Friendly Port Name.
9. If desired, select a different COM Name (NS-Link COM port number). The 

drop-down list displays (in use) next to COM port numbers that are already in 
use in this system. Do not duplicate COM port numbers as this will cause the 
ports to not function.

10. Click Apply to save these changes.
Note: If you selected RS-422 mode, make sure that there is not a device 

attached to the port and click Ok.
11. Highlight the next port that you want to configure and perform Steps 4 

through 10. 
The following table provides detailed information about the options on the port 
General tab.
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Port Settings General 
Tab Description

RS Mode

Default = RS-232

Use this drop-down list to select the communications mode for the 
serial device that you will be connecting to this port.
• RS-232
• RS-422 
• RS-485 Mode provides these choices, depending on the model.

Note: The DeviceMaster LT and DeviceMaster RTS 2-port 
models support RS-485 4-wire, Slave or Master. The 
DeviceMaster PRO and other DeviceMaster RTS models 
only support RS-485 2-wire.

- RS-485 2-wire (half-duplex) supports transmit and receive 
data. When data is transmitted, the Transmit Enable signal 
is activated, and the transmit receive device switches from 
receive to transmit automatically.

- RS-485 4-wire Master (full-duplex master) supports transmit 
and receive data, which means both signals are always 
active. The DeviceMaster is enabled by the Transmit 
Enable signal. This mode is the same as RS-422.

- RS-485 4-wire Slave (full-duplex slave) supports transmit and 
receive data. When data is transmitted, the Transmit 
Enable signal is activated, the transmit device goes active 
and starts sending data. When the data is not being sent, 
the transmit device is inactive. The receive device is always 
active. If you click RS-485, you may need to change settings 
in the RTS Toggle Options screen.

Note: The DeviceMaster Serial Hub default value is RS-422, the 
default value is RS-232 for other DeviceMasters.

Override and Lock Baud Rate 
to

Default = None

This option allows you to lock selected ports.
You can select a value from the drop-down list or enter an 
appropriate value from the following standard baud rates: 300, 600, 
1200, 1800, 2400, 3600, 4800, 7200, 9600, 14400, 19200, 38400, 
57600, 115200, 230400, 460800, or 921600. 
After locking a baud rate, no matter what baud rate is selected in a 
host application, the actual rate used is the rate specified here.

RTS Toggle Options

This button opens the RTS Toggle Options popup, which provides 
the following features:
• Override and Lock to RS-485 Toggle Mode 

Use the Override and Lock to RTS Toggle Mode option to lock the 
port in RTS (Request to Send) toggle mode, then set the mode 
(low or high) as desired for RS-485 mode.

• RS-485 Toggle RTS Low 
Use the RTS Toggle RTS Low option to toggle the RTS output 
signal low during data transmission, which may be needed for 
relay devices for RS-485.
If the option box is not checked, RTS is toggled high (asserted) 
during data transmission for RS-485 mode.

• Defaults 
Clicking the Defaults button returns all the values in the RTS 
Toggle Options popup to their default state:
- Override and Lock to RTS Toggle Mode = Disabled
- RTS Toggle RTS Low = Disabled
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Terminator Resistor Options

(DeviceMaster LT, Only)

Optionally, click the Terminator Resistor button to enable 
termination resistors.
To ensure the best signal integrity on a long distance high-speed 
RS-422 or RS-485 network, sometimes it is required to place a 
120Ω termination resistor between each of the transmit differential 
pair or receive differential pair. 
Signal reflection is reduced and a reliable communication is 
ensured by placing the 120Ω termination resistor. The 
DeviceMaster LT provides software controllable 120Ω termination 
resistor for each differential pair on every port in RS-422 and RS-
485 mode. Use the Termination Resistor Options popup to place 
120Ω termination resistors between the signals shown below:
• RS-422 Mode

- Between TxD+ and TxD- (Pins 5 and 7)
- Between RxD+ and RxD- (Pins 4 and 2)

• RS-485 Mode – Between TxD/RxD+ and TxD/RxD- (Pins 5 and 
7) 

Transmit Data Timeout Port 
Close

Default = 0

This option allows you to select the length of time to wait for data to 
clear the transmit buffer after a host application has closed the 
port. This is typically used with serial devices such as printers, to 
give the data sufficient time to flush through the system.

Map 2 Stop Bits to 1

Default = Disabled

If your application is hard-coded to use two stop bits and you 
receive framing errors, click this check box to map 2 stop bits to 1 
bit. 
Leave this check box blank to enable stop bits to pass through 
unchanged.

Wait on Physical Transmission 
before Completing Write

Default = Disabled

This option forces all write packets to wait until the transmit data 
has physically completed the transmission before returning 
completion to the host application. 
The default mode (check box not clicked) is to buffer the data in the 
transmit hardware buffer, and return completion as soon as the 
packet is in the buffer.

Emulate Modem Hardware 
RING Signal

Default = Disabled

Click this check box to emulate the ring indicator signal. 
If this box is checked and the port receives a RING signal (or an 
alternate code, as defined in the AT command set for the modem), it 
sends an RI signal to the communications application.

Block PnP search for attached 
serial device

Default = Disabled

This option disables plug and play from searching for a device 
attached to the serial port.
For example, data received during device discovery on a device is 
assumed to be a mouse to plug and play.

Allow Parity Conflict 
(DeviceMaster 1-Port only)

Default = Disabled

Use this option to allow a parity conflict on a DeviceMaster 1-port. 
It may be necessary to use this option after you have determined 
that the cabling is correct and you are able to transmit data but not 
receive proper data.

Clone: Apply all the settings to 
all ports

Default = Disabled

If this check box is not clicked, changes apply to the selected port 
only. 
If this check box is clicked, changes apply to all ports on this board.

User-Friendly Port Name You can enter a custom COM port name to identify this 
DeviceMaster in the Comtrol Drivers Management Console.

Port Settings General 
Tab Description
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COM Name

The COM Name drop list allows you to renumber this COM port. If 
you see a COM port number followed by (in use), this means that 
Plug and Play sees those COM port numbers in use by another 
device.
If you renumber this COM port and click the Renumber All 
Subsequent Ports Relative to The Port option, the device driver will 
renumber all of the ports on the DeviceMaster, starting with the 
number you select in this drop list.
If you rename the port to a COM name used by another port, a 
dialog appears indicating that the port is already in use.

Renumber All Subsequent 
Ports Relative to the Port

Default = Disabled

Use the Renumber All Subsequent Ports Relative to This Port option to 
renumber all subsequent ports on the DeviceMaster relative to the 
port displayed in the COM name drop list.

Defaults

Default = Disabled
Click the Defaults button to return to the driver default values.

Port Settings General 
Tab Description
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Network Configuration in Comtrol Drivers Management Console

Comtrol recommends using PortVision DX to configure network settings.
Optionally, you can use the Comtrol Drivers Management Console to:
• Disable IP communications.
• Change the IP address (if the MAC address has been associated to the 

DeviceMaster), see Changing a Static IP Address on Page 50.
• Configure the DeviceMaster for use with DHCP, see Setting Up DHCP on Page 

51.

Disabling IP Mode Use this procedure if you want to disable IP communications.
1. If necessary, access the Comtrol Drivers Management Console.

Note: The DeviceMaster must be operational in MAC mode on a local network 
segment or connected directly to the PC (Associating the MAC Address 
on Page 36).

2. Make sure that the MAC Mode radio button has been selected.
3. Highlight the Device Name of the 

DeviceMaster that you want to 
configure.

4. Click the Network Settings button.
5. Click the Modify button.
6. Click Disable IP. 

You can use the Disable IP option if you 
are not using IP addressing (DHCP or 
static) and operating the DeviceMaster 
in MAC mode. 

7. Click the Apply Changes button.
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8. Click Yes to the Warning popup.
After the DeviceMaster is rebooted, 
the following occurs:
• In PortVision DX, the IP address 

displays as 0.0.0.0.
• In the Comtrol Drivers 

Management Console:
- The IP address in the Network Settings popup displays 255.255.255.255.
- If the DeviceMaster had been set to IP Mode, the previously programmed 

IP address will appear in the IP Mode text box. You can delete the IP 
address from the IP Mode text box and click Apply to clear the IP address 
from the text box.

9. Click Close to return to the Comtrol Drivers Management Console.
After disabling IP communications, you may need to do the following:

• Configure device properties, see Configuring Device Properties on Page 40.
• Configure COM port properties, see Configuring COM Port Properties on 

Page 43.
• Configure any of the DeviceMaster ports as sockets, see Configuring 

DeviceMaster Ports as Sockets on Page 53.

Changing a Static IP 
Address 

Typically, PortVision DX is used to program the IP address into the DeviceMaster 
during initial configuration. After associating the DeviceMaster with the MAC 
address you can change the IP address using the Comtrol Drivers Management 
Console.
1. Before programming an IP address it is critical that the DeviceMaster be 

operational (the PWR or Status LED is lit) when configured for the MAC 
address (Associating the MAC Address on Page 36). 
Note: If the DeviceMaster is NOT operational, do NOT attempt to program or 

use an IP address with the DeviceMaster.
2. Highlight the Device Name of the 

DeviceMaster that you want to 
configure.

3. Click the Network Settings button.
4. Click the Modify button.
5. Click Static IP.
6. Enter static IP address information in 

the fields below.
a. IP Address: Enter a valid IP address 

for your network. The IP Address 
field is the IP address programmed 
into the DeviceMaster after 
applying the changes and rebooting 
the DeviceMaster. See your network 
administrator for a valid IP address.

b. Mask: The subnet mask is a 32-bit value (255.x.x.x) that enables IP 
packets to distinguish the network ID and host ID portions of the IP 
address that filters traffic.

c. Gateway: The default gateway is a TCP/IP configuration item that is the IP 
address of a directly reachable IP router.
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7. Click Apply Changes to begin 
programming the DeviceMaster.

8. Click Yes to the WARNING popup 
message.

9. Click Yes to the next WARNING popup 
message about rebooting the 
DeviceMaster.

If you do not reboot the DeviceMaster at this time, the IP address is not 
implemented on the DeviceMaster. Failure to reboot at this time can cause 
network communication problems later, if the IP address is not programmed 
into the DeviceMaster. Comtrol support recommends rebooting the 
DeviceMaster at this point.

10. Click Close to return to the Device General tab.
11. Optionally, you can click the Advanced tab and verify that the Device Status 

message indicates that the Device is active and Ok.
12. After programming the IP address, you may need to do the following:

• Configure device properties, see Configuring Device Properties on Page 40.
• Configure COM port properties, see Configuring COM Port Properties on 

Page 43.
• Configure any of the DeviceMaster ports as sockets, see Configuring 

DeviceMaster Ports as Sockets on Page 53.

Setting Up DHCP After associating the DeviceMaster with the MAC address you can configure the 
driver to work using DHCP.
1. Before programming an IP address it is critical that the DeviceMaster be 

operational (the PWR or Status LED is lit) when configured for the MAC 
address (Associating the MAC Address on Page 36). 
Note: If the DeviceMaster is NOT operational, do NOT attempt to program or 

use an IP address with the DeviceMaster.
2. Highlight the Device Name of the DeviceMaster that you want to configure.
3. Click the IP Mode radio button.
4. Click the Network Settings button.
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5. Click the Modify button.

6. Click DHCP IP. This option allows 
DHCP to assign the IP address. Make 
sure that you provide the MAC address 
of the DeviceMaster for the network 
administrator to assign a static IP 
address from the pool. The DHCP 
server should assign the IP address, 
mask, and IP gateway.

7. Click Apply Changes.
8. Click Yes to the WARNING popup 

message.

9. Click Yes to the next WARNING popup 
message.
If you do not reboot the DeviceMaster at this 
time, the IP address is not implemented on 
the DeviceMaster. Failure to reboot at this 
time can cause network communication 
problems. Comtrol support recommends 
resetting the DeviceMaster.
After the DeviceMaster reboots, the following occurs:
• The Comtrol Drivers Management Console displays the IP address (0.0.0.0) 

and subnet mask (255.255.0.0) values in the Network Settings popup.
• PortVision DX will display the IP address assigned by DHCP.

10. Click Close to return to the Device General tab.
11. Optionally, you can click the Advanced tab and verify that the Device Status 

message indicates that the Device is active and Ok.
12. After programming the IP address, you may need to do the following:

• Configure device properties, see Configuring Device Properties on Page 40.
• Configure COM port properties, see Configuring COM Port Properties on 

Page 43.
• Configure any of the DeviceMaster ports as sockets, see Configuring 

DeviceMaster Ports as Sockets on Page 53.
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Configuring DeviceMaster Ports as Sockets

DeviceMaster ports can also be configured as sockets. To configure sockets, use the 
following procedure:
1. Use one of these methods to open the socket configuration web interface 

(SocketServer). 
• In PortVision DX, right-click the DeviceMaster and click Webpage.
• Enter the IP address of the DeviceMaster in your web browser URL field or 

highlight the DeviceMaster in PortVision DX and click Web Manager.
2. Click the port number that you want to configure as a socket.

See the web page help system, if you need information about configuring sockets 
or serial tunneling. Optionally, you can refer to the DeviceMaster Installation and 
Configuration Guide.
The web page help is also available separately if you want a local copy on your 
host system. The help files are on the Software and Documentation CD and the 
latest version can be downloaded at: ftp://ftp.comtrol.com/dev_mstr/rts/software/
SocketServer/help/ssvr_help.zip.
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Enabling Secure Data Mode

In addition to enabling SSL mode in the driver, you must Enable Secure Data Mode 
in the NS-Link web page. Use the following procedure to implement the Enable 
Secure Data Mode option.
1. Access the NS-Link web page using one of these methods:

• Open your web browser, enter the IP address, and click enter.
• Right-click the DeviceMaster in the Device Tree or Device List pane in 

PortVision DX and click Webpage.
2. Click the Security tab.
3. Click Enable Secure Data Mode and Save.

4. Configure your security key and certificate and click Set. 

Click the Help button if you need information about key and certificate 
management.
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Using Driver Configuration Files

The Comtrol Drivers Management Console supports saving device driver 
configuration files, which provides:
• Back-up for existing driver configuration settings
• Ability to configure multiple of the same devices with the same configuration 

parameters
• Save the driver configuration settings because you need to remove a driver 

version to install a new driver version and you want to reload the driver 
configuration settings into the new driver

Note: Configuration files must be for the same model with the same port density. 
For example, you cannot load a DeviceMaster PRO configuration file onto a 
DeviceMaster RTS or a configuration file for a 32-port DeviceMaster RTS 
onto a 4-port  DeviceMaster RTS.

Configuration files are saved with a .DCF extension.

Saving Driver Configuration Files

Use the following procedure to create and save a configuration file.
1. After configuring the device and ports, click Save Configuration.
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2. Optionally, change the default file name and click Save.

Loading a Driver Configuration File

You must have previously saved a configuration file before you can load a 
configuration file.
The driver configuration file uploads in portions:
• If you highlight a device and click Load Configuration and Apply for the device-

level configuration parameters to reload on the device. 
• To load port-level configuration parameters, you must highlight a single port 

and click Load Configuration and Apply. You must upload each port's 
configuration parameters separately.

Loading Device 
Configuration

Use the following procedure to load the configuration file for device-level 
information for your device. 
1. If necessary, open the Comtrol Drivers Management Console using one of these 

methods:
• Windows Control Panel; go to your Control Panel and click on the 

Comtrol Drivers Management Console.
• Shortcut; located under Start > Program Files > Comtrol > Product_Name > 

Comtrol Drivers Management Console. 
2. Depending on your operating system, you may need to click Yes to the Do you 

want to allow the following program to make changes to this computer? User 
Account Control message.
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3. In the left pane, highlight the device for which you want to load the device-
level settings from the configuration file.

4. Click Load Configuration.
5. Browse to the location of the configuration file that you want to load.
6. Highlight the configuration 

file and click Open. The 
configuration file loads in a 
few moments. 

7. Make the appropriate 
choice for your situation:
• Click No to the 

ComtrolApplet message, 
if you are using the file 
to set up multiple 
devices with the same 
device-level settings.

• Click Yes to the 
ComtrolApplet message, 
if you are using the file 
to restore a specific 
device. For example, 
you needed to remove and then re-install the DeviceMaster NS-Link device 
driver. 

8. Click Apply so that the configuration is saved on the device.
9. Go to the next procedure if you want to restore port settings from a 

configuration file.
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Loading Port 
Configuration

Use the following procedure to load the configuration file for port-level settings for 
your device. 
Note: Device driver configuration files must be for the same model with the same 

port density. For example, you cannot load a DeviceMaster PRO 
configuration file onto a DeviceMaster RTS or a configuration file for a 32-
port DeviceMaster RTS onto a 4-port DeviceMaster RTS.

1. If necessary, open the Comtrol Drivers Management Console using one of these 
methods:
• Windows Control Panel; go to your Control Panel and click on the 

Comtrol Drivers Management Console.
• Shortcut; located under Start > Program Files > Comtrol > Product_Name > 

Comtrol Drivers Management Console. 
2. Depending on your operating system, you may need to click Yes to the Do you 

want to allow the following program to make changes to this computer? User 
Account Control message.

3. In the left pane, highlight the port for which you want to load the port-level 
settings from the configuration file.

4. Click Load Configuration.
5. Browse to the location of the configuration file that you want to load.
6. Highlight the 

configuration file and click 
Open. The configuration 
file loads in a few 
moments. 
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7. Make the appropriate choice for your situation:
• Click No to the ComtrolApplet message, if you are using the file to set up 

multiple devices with the same port-level settings.
• Click Yes to the ComtrolApplet message, if you are using the file to restore 

a specific device. For example, you needed to remove and then re-install the 
DeviceMaster NS-Link device driver.

8. Click Apply so that the configuration is saved on the device.
9. Repeat Steps 3 through 8 for each port that you want to restore.
DeviceMaster Driver User Guide: 2000531 Rev. E Loading Port Configuration - 59



 Using Driver Configuration Files 
60 - Loading Port Configuration DeviceMaster Driver User Guide: 2000531 Rev. E



Removing the DeviceMaster and Driver

This section discusses:
• Removing a DeviceMaster from an installation without removing the NS-Link 

device driver from your system
• Removing the NS-Link Device Driver from your system

Removing a DeviceMaster

Use the following procedure to uninstall the device driver.
Note: Administrative privileges are required to remove device drivers on Windows 

operating systems newer than Windows Server 2003.
1. Right-click the DeviceMaster that you want to uninstall in the Tree View 

pane.
2. Click Uninstall.
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Removing the NS-Link Device Driver

Use the following procedure to remove the DeviceMaster device driver.
1. From the Start button, click the shortcut for your DeviceMaster: Programs > 

Comtrol > DeviceMaster > Driver Installation Wizard.
2. Click Next to start the Comtrol Driver Installation Wizard.
3. Click Remove All and Next.

4. Click Next to remove the driver.
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5. Click Proceed to continue the driver removal process.

6. Click the Reboot My Computer button or Close.

• If you click Close, make sure that you reboot the system and remove the 
adapter to complete the driver removal.

• If you click Reboot My Computer, click Ok. 

7. Shutdown the system and disconnect the DeviceMaster from your network.
8. If you want to totally remove the .exe driver assembly:

a. Delete any copies of the .exe driver assembly file residing on the system.
b. Delete the driver and devices using the Add > Remove Programs Control 

Panel.
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Troubleshooting and Technical Support

This section contains troubleshooting information for your DeviceMaster and the 
NS-Link device driver. You should review the following subsections before calling 
Technical Support because they will request that you perform many of the 
procedures or verifications before they will be able to help you diagnose a problem.
• How to Find Diagnostic Tools and Utilities
• Troubleshooting Checklist on Page 66
• General Troubleshooting on Page 67
• Connectivity Requirements on Page 68
• DeviceMaster LEDs on Page 70
• Using the Advanced Tab on Page 72
• NS-Link Driver Troubleshooting on Page 77
• Using Port Monitor to Test Ports on Page 78
• Using Test Terminal on Page 81
• How Disable/Enable the Device Driver on Page 86
• Technical Support on Page 87
If you cannot diagnose the problem, you can contact Technical Support on Page 87. 

How to Find Diagnostic Tools and Utilities

There are several tools and utilities that Comtrol provides to diagnose serial port 
problems or to monitor data.
• The Advanced tab in the Comtrol Drivers Management Console (Using the 

Advanced Tab on Page 72), which may provide valuable information about the 
DeviceMaster and your network, in the event that you are having problems.

• PortVision DX (Page 7) that provides the following features:
- Auto-discover and organize Comtrol Ethernet attached products on your 

network. 
- Remotely access, manage, and configure Comtrol Ethernet attached 

products from a central console. 
- Load network configuration settings onto multiple Comtrol Ethernet 

attached products - quickly and easily. 
- Instantly view connection status, firmware revision, and network settings 

of all servers. 
- Configure serial ports using TCP sockets, port communication, and 

interface settings. 
- Visualize each server and port with instant links to connector, power, and 

serial pinout information. 
- Conveniently customize and save your network view and commands for 

replication across all servers. 
- Includes the Test Terminal (WCom2) and Port Monitor (PMon2) programs 

for easy access.
- Test Terminal can be used to troubleshoot communications on a port-by-

port basis.
- Port Monitor can check for errors, modem control, and status signals. In 
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Troubleshooting Checklist
addition, it provides you with raw byte input and output counts
Test Terminal and Port Monitor are installed and available if you install 
PortVision DX. You can refer to the Port Monitor and Test Terminal User 
Guide for testing procedures.

Troubleshooting Checklist 

Most customer problems reported to Comtrol Technical Support are eventually 
traced to cabling or network problems.
Reboot the system and reset the power on the DeviceMaster, watch the PWR or 
Status light activity. See DeviceMaster LEDs on Page 70 for information about the 
diagnostic LEDs.
• If the DeviceMaster has a power switch, turn the DeviceMaster power switch 

off and on. 
• If the DeviceMaster does not have a power switch, disconnect and reconnect 

the power cord.

 The following table may help you diagnose your problem:

PWR or Status LED Description

5 sec off, 3 flashes, 5 sec off, 3 flashes ... Redboot checksum failure.

5 sec off, 4 flashes, 5 sec off, 4 flashes ... SREC load failure.

5 quick flashes The default application is starting 
up.

10 sec on, .1 sec off, 10 sec on .1 sec off ... The default application is running.

Issue Check

Cabling?
Verify that you are using the correct types of cables on the correct 
connectors and that all cables are connected securely using the 
DeviceMaster Installation and Configuration Guide (Page 7).

Network?

• Isolate the DeviceMaster from the network by connecting the 
DeviceMaster directly to a NIC in a host system. 

• See Connectivity Requirements on Page 68 for network 
cabling information. 

• Reduce network traffic by installing a second NIC in the host 
and connect directly to the DeviceMaster. 

• Verify that the Ethernet hub, switch, or router and any other 
network devices between the system and the DeviceMaster 
are powered up and operating.

Correct MAC 
address?

Verify that the hardware MAC address in NS-Link matches the 
address on the DeviceMaster label. You can also use PortVision 
DX to verify the MAC and IP addresses.

Correct IP 
address?

• Verify that the network IP address is correct. If IP addressing 
is being used, the system should be able to ping the 
DeviceMaster.

• Verify that the IP address programmed into the 
DeviceMaster matches the unique reserved IP configured 
address assigned by the system administrator.
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General Troubleshooting
Note: If you have a spare DeviceMaster, try replacing the DeviceMaster. 

General Troubleshooting

This table illustrates some general troubleshooting tips.
Note: Make sure that you have reviewed the Troubleshooting Checklist on Page 66.

Correct port 
addressing?

If using the NS-Link device driver with an in-house application, 
verify that you are addressing the port correctly. In many 
applications, device names above COM9 require the prefix \\.\ 
in order to be recognized. For example, to reference COM20, use 
\\.\COM20 as the file or port name.

Is this the 
Latest Driver? See Checking the Device Driver Version on Page 22.

Test the Port 
or Ports? Install PortVision DX (Page 11) and use Test Terminal (Page 81).

Comtrol 
Drivers 
Management 
Console?

Verify that the DeviceMaster has installed using the Comtrol 
Drivers Management Console to confirm that the DeviceMaster 
displays. Install the device driver, if the DeviceMaster is not 
displayed.

Enable 
Verbose mode

Enable the Verbose Event Log feature on the Device General and 
then reboot the system.

Issue Check

General Condition Explanation/Action

PWR or Status LED 
flashing

Indicates that boot program has not downloaded to the 
DeviceMaster.
1. If applicable, remove the NS-Link driver.
2. Make sure that you have downloaded the most 

current driver from ftp://ftp.comtrol.com/dev_mstr/
rts/drivers/win7. 

3. Install the driver and configure the DeviceMaster 
using the MAC address. Make sure that you reboot 
the system. Refer to NS-Link Device Driver 
Installation on Page 17 for installation 
information.
Note: If the PWR or Status LED is still flashing, 

contact Technical Support.

PWR or Status LED not 
lit

Indicates that power has not been applied or there is a 
hardware failure. Contact Technical Support.
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Connectivity Requirements
Connectivity Requirements

An Ethernet connection: either to an Ethernet hub, switch, or router; or to a 
Network Interface Card (NIC) in the host system using a standard Ethernet cable. 
See the DeviceMaster Installation and Configuration Guide (Page 7) for 
information regarding hardware installation.

Can ping the Comtrol 
device, but cannot open 
the ports from a remote 
location. 
(You must have 
previously programmed 
the IP address, subnet 
mask, and IP gateway.)

The NS-Link driver uses Port 4606 (11FE h) to 
communicate with the DeviceMaster. 
When using a sniffer to track NS-Link packets, 
filtering for Port 4606 will easily track the packet. The 
packet should also contain the MAC address of the 
DeviceMaster and the originating PC so that it can be 
determined if the packet is able to travel the full 
distance one way or not. 
If the 4606 packet is found on one side of a firewall or 
router, using sniffer, and not on the other side, then 
that port needs to be opened up to allow the 4606 to 
pass. 
This will most often be seen with firewalls, but is also 
seen in some routers.

Cannot ping the device 
through Ethernet hub, 
switch, or router

Isolate the DeviceMaster from the network. Connect 
the DeviceMaster directly to the NIC in the host 
system (see Connectivity Requirements on Page 68).

Cannot ping or connect 
to the DeviceMaster

The DeviceMaster family default IP address is often 
not accessible due to the subnet masking from another 
network unless 192.168 is used in the network. 
In most cases, it will be necessary to program in an 
address that conforms to your network. 
If you do not use the NS-Link driver to program the IP 
address, you only have 10 seconds to disable the 
bootloader with Redboot to get into the setup utility. 
See the DeviceMaster Installation and Configuration 
Guide (Page 7) for the Redboot method of programming 
an IP address.

General Condition Explanation/Action

Product Type Connected to Connector Name

DeviceMaster RTS 1-port Hub, switch, 
router, or NIC 10/100 ETHERNET

DeviceMaster RTS Embedded Hub, switch, 
router, or NIC

RJ45 port (not 
labeled)

DeviceMaster RTS 2-port 1E
NIC

10/100Hub, switch, or 
router

DeviceMaster RTS 2-port 2E
NIC

10/100 1E/2EHub, switch, or 
router
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Connectivity Requirements
DeviceMaster RTS 4/8/16-port 
(external power supply)

NIC DOWN

Hub, switch, or 
router UP

DeviceMaster RTS 16/32RM 
(internal power supply)

Hub, switch, 
router, or NIC 10/100 NETWORK

DeviceMaster PRO 8/16-port
NIC DOWN

Hub, switch, or 
router UP

DeviceMaster Serial Hub 8-port
NIC DOWN

Hub, switch, or 
router UP

DeviceMaster Serial Hub 16-port Hub, switch, 
router, or NIC 10/100 NETWORK

Product Type Connected to Connector Name
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DeviceMaster LEDs
DeviceMaster LEDs

The DeviceMaster has network and port LEDs to indicate status.

Port LEDs Port LEDs are amber and green on 4, 8, 16, and 32-port. The 1-port and 2-port 
models do not have port LEDS. After a port has been opened in RS-232 mode, an 
amber LED means that there is link between the port and the serial device. After 
a port has been opened in RS-422 or RS-485 mode, an amber LED means that data 
is receiving data. A green port LED indicates transmit activity.

Network and Device 
LEDs

The LEDs indicate that the default DeviceMaster application, SocketServer is 
running or after driver installation, that the NS-Link driver loads. If you have 
loaded PortVision DX, you can check the DeviceMaster status on-line.

Ports Model Network LEDs

1 DeviceMaster 
RTS

• The Status LED on the front of the unit is lit, which 
indicates that it has power and has completed the 
boot cycle.
Note: The Status LED flashes while booting and it 

takes approximately 15 seconds for the 
bootloader to complete the cycle. When the 
Bootloader completes the cycle, the LED has a 
solid, steady light that blinks approximately 
every 10 seconds.

• The red Link Act LED is lit, which indicates a 
working Ethernet connection.

• If the red Duplex LED is lit, it indicates full-duplex 
activity.

• If the red 100 LED is lit, it indicates a working 100 
MB Ethernet connection (100 MB network, only).

1
DeviceMaster 

RTS
Embedded

The LEDs are located between the RJ45 connector and 
the power terminal block.
• The amber Status LED (D1) on the adapter is lit, 

which indicates that it has power and has completed 
the boot cycle.
Note: The Status LED flashes while booting and it 

takes approximately 15 seconds for the 
bootloader to complete the cycle. When the 
Bootloader completes the cycle, the LED has a 
solid, steady light that blinks approximately 
every 10 seconds.

• The red Link Act LED (D2) is lit, which indicates a 
working Ethernet connection.

• If the red Duplex LED (D3) is lit, it indicates full-
duplex activity.

• If the red 100 LED (D4) is lit, it indicates a working 
100 MB Ethernet connection (100 MB network, 
only).
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2 DeviceMaster 
RTS

• The STATUS LED on the device is lit, indicating you 
have power and it has completed the boot cycle.
Note: The STATUS LED flashes while booting and it 

takes approximately 15 seconds for the 
Bootloader to complete the cycle. When the 
Bootloader completes the cycle, the LED has a 
solid, steady light that blinks approximately 
every 10 seconds.

• If the LINK (green) LED is lit, it indicates a working 
Ethernet connection.

• If the ACT (yellow) LED flashes, it indicates network 
activity.

4

8

16

DeviceMaster 
PRO (8)

DeviceMaster 
RTS†

DeviceMaster 
Serial Hub (8)

• The PWR LED on the front of the unit is lit, which 
indicates it has power and has completed the boot 
cycle. 
Note: The PWR LED flashes while booting and it 

takes approximately 15 seconds for the 
bootloader to complete the cycle. When the 
Bootloader completes the cycle, the LED has a 
solid, steady light that blinks approximately 
every 10 seconds.

• The red LNK/ACT LED is lit, which indicates a 
working Ethernet connection.

• If the red 100 LED is lit, it indicates a working 100 
MB Ethernet connection (100 MB network, only).

16

32

DeviceMaster 
PRO (16)

DeviceMaster 
RTS††

DeviceMaster 
Serial Hub 

(16)

• The Status LED on the front of the unit is lit, which 
indicates it has power and has completed the boot 
cycle. 
Note: The Status LED flashes while booting and it 

takes approximately 15 seconds for the 
bootloader to complete the cycle. When the 
Bootloader completes the cycle, the LED has a 
solid, steady light that blinks approximately 
every 10 seconds.

• The red LNK/ACT LED is lit, which indicates a 
working Ethernet connection.

• If the red Duplex LED is lit, it indicates full-duplex 
activity.

• If the red 100 LED is lit, it indicates a working 100 
MB Ethernet connection (100 MB network, only).

†  External power supply.
††  Internal power supply.

Ports Model Network LEDs
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Using the Advanced Tab

You can use the Advanced tab to get a summary of the DeviceMaster status. The 
Advanced tab can be useful for troubleshooting network problems with your 
DeviceMaster.
Note: To use the Advanced tab, you must associate a MAC address to the 

DeviceMaster before programming an IP address (Page 36).
Use the following procedure to access the Advanced tab.
1. If necessary, access the Comtrol Drivers Management Console.
2. Highlight the DeviceMaster.
3. Click the Advanced tab.

Note: You must have previously associated a MAC address to the 
DeviceMaster (Associating the MAC Address on Page 36).

Refer to the Device Status table (Page 75) for a list of messages and 
explanations.

4. You can click the History button to review the last ten actions on the 
DeviceMaster.
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5. Click PC Network Interface Details for the following information. 

Click Close to return to the Advanced tab.

Field Description

MAC Address
MAC Address is the reported MAC address of the Ethernet network 
interface card (NIC) card in the server. Since a server may contain 
more than one NIC, identifying exactly which NIC is being used by 
the device driver may help you to identify and resolve problems.

Frames Out

Frames Out is the count of the number of frames output by the device 
driver through the identified network interface. This includes all 
administrative, data, and control frames, and should be incriminated 
whenever the DeviceMaster and the device driver are operating, even 
if the DeviceMaster is idle.

Frames 
Accepted

Frames Accepted is the count of the number of received frames 
accepted by the device driver for further processing. These must be 
well-formed packets with the correct protocol identifiers for the device 
driver.

Frames Passed 
On

Frames Passed On is when a NIC receives a packet, it passes the 
packet around to each driver or application that is bound to the NIC 
until one of them recognizes and accepts the packet.

Adapter 1 ID 
String

Adapter 1 ID String is the NIC binding string. Every network entity 
that needs to be uniquely identified has a Globally Unique Identifier 
(GUID), which is used to form unique binding strings. The presence of 
this string indicates that the device driver has been bound to a 
specific NIC.

Reset This button resets the statistics in the PC Network Interface window.
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6. Click the Device Network Interface Details button to review the following 
information.

Click Close to return to the Advanced tab.

Fields Description

MAC Address
MAC Address is the network (MAC) address of the DeviceMaster that 
is currently selected. It should match both the MAC address on the 
General tab and the MAC address on the physical DeviceMaster.

Packets To Packets To is the count of information frames sent to a layer in the 
device driver and indicates actual data traffic sent.

Packets From Packets From is the count of information frames received by a layer in 
the device driver, and indicates actual data traffic received.

Retransmitted/% 
All Sent

Retransmitted/% All Sent is the percentage of information frames 
requiring retransmission due to network errors. If this value is not 
zero, you may have network problems.

Reported State Reported State contains a message showing the status of the device 
driver to the selected DeviceMaster.

Devices Detected/
Available

Devices Detected/Available is the number of DeviceMasters found on 
the network and how many of the DeviceMasters are available.

Out of Sequence/ % 
of All Received

Out of Sequence/ % of All Received is the percentage of information 
frames received out of order, possibly due to network errors. If this 
value is not zero, you may have network problems.

Maximum Average 
Buffer Usage

Maximum and Average Buffer Usage is the percentage of the network 
buffer used since the driver was loaded.

Buffer Allocation 
Failures

Buffer Allocation Failures displays how many times the driver failed to 
allocate network buffers to the process because there were not enough 
buffers.

Starving Port(s)
If any Buffer Allocation Failure happens, the Starving Port(s) list will 
include the name of the COM port that could not be serviced 
(immediately) because of it.

Reset
Reset clears the data values from the fields. and updates the data 
displayed in the event that you want review data before the automatic 
refresh cycle occurs.
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The following table provides a list of Device Status messages.

Device Status Message Description

A MAC address has not yet been 
specified for this device. Return to 
the General tab, configure the device, 
and apply the changes.

The driver may have only been configured with an 
IP address. The appropriate MAC address must be 
input in the MAC field in the General tab so that the 
Advanced tab can report DeviceMaster status.

Can't detect any Comtrol devices. 
Check Ethernet connectors and 
ensure the device is powered on.

Network traffic is being received, but not from a 
DeviceMaster. Check the network connections and 
verify that the DeviceMaster is powered up.

Can't detect the device with specified 
the MAC address on any network. 
Verify the MAC address of the unit, 
check the Ethernet connectors and 
ensure the device is powered on.

Network traffic is being received from a 
DeviceMaster, but not the one specified on the 
General tab. Check the DeviceMaster to make sure 
that you are using the correct MAC address.

Code upload failed due to a timeout 
and the driver is attempting to re-
synchronize with the device.

The device driver has not successfully uploaded the 
firmware to the assigned DeviceMaster.

Code upload has completed. The driver has completed uploading the firmware to 
the DeviceMaster.

Code upload was restarted after a 
timeout.

The firmware upload process failed due to a time-
out. The upload process has been restarted.

Device detected, initializing.
The server has acquired the DeviceMaster and is 
downloading the control program. The DeviceMaster 
will be available shortly.

Device detected, microcode upload in 
progress.

The device driver is attempting to upload the 
microcode to the DeviceMaster. This should 
complete momentarily.

Device is active and OK, no data 
traffic was exchanged since last 
inquiry.

The DeviceMaster and ports are operational. There 
is currently no active serial traffic.

Device is active and OK. The DeviceMaster is okay and ready to use.

Device is detected and configured in 
the driver, but is not yet assigned to 
this server/PC.

Either the DeviceMaster is currently being 
controlled by another server or the DeviceMaster 
power has been cycled and the DeviceMaster is 
waiting for a server to acquire it.

Excess out-of-sequence packets 
received. Check for indications of 
high network traffic.

Click the PC Network Interface Details button to 
review the statistics, which may indicate that 
DeviceMaster is functioning properly. 
This message typically goes away on it's own but you 
can reboot the PC so that the network traffic is re-
synchronized.

Excess packet retransmissions 
detected. Check for indications of 
high network traffic.

Click the PC Network Interface Details button to 
review the statistics, which may indicate that 
DeviceMaster is functioning properly. This message 
typically goes away on it's own but you can reboot 
the PC so that the network traffic is re-
synchronized.

Initialization complete. Waiting on 
response from the device before 
making the connection active.

Waiting for a response from the DeviceMaster.

Statistical data was reset.
This indicates the number of times that the 
statistics in the PC Network Interface and Device 
Network Interface have been reset.
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The driver is not running. If you just 
installed the driver you will need to 
exit the program before the driver 
starts.

Close and then re-open the Comtrol Drivers 
Management Console.

The communications between the 
driver and the device has been 
disrupted. Check connectors, cabling, 
and look for indications of high 
network traffic.

The DeviceMaster is off-line in this state. The MAC 
or IP address for the DeviceMaster is known 
(assigned) but communications have been 
interrupted.

The device has failed to respond for 
an extended period of time. The 
device may have lost power or is in 
an unresponsive state.

The device driver is no longer able to communicate 
with the DeviceMaster. Check the LED status (Page 
70).

The driver is not running. Make sure 
the driver is installed correctly and 
restart the PC to correct the 
problem.

Make sure the driver is installed correctly and 
restart the PC to correct the problem. The driver is 
most likely disabled. Enable the driver and reboot 
the PC.

Timeout occurred while the driver 
was waiting for an ADMIN command 
reply from the device.

There may be network traffic problems, an 
unresponsive DeviceMaster, or a problem with the 
server sending out network data. 
The device driver is trying to locate the 
DeviceMaster on the network by sending out the ID 
request and not receiving a response from the 
DeviceMaster, which may indicate that the 
DeviceMaster is either not on the network, on a 
different segment (if using MAC mode of 
addressing), or the bandwidth of the network (or 
server) is so saturated that the DeviceMaster 
response is not received in time.

Timeout occurred while the driver 
was waiting for an Assign Reply 
response from the device prior to 
making the connection active.

There may be network traffic problems, an 
unresponsive DeviceMaster, or a problem with the 
server sending out network data. A handshake that 
occurs after an ID response is received and the 
device driver is trying to establish a communication 
channel with the DeviceMaster.

Unable to find a Network Interface 
Controller (NIC) card.

Install a NIC in that PC or check that the NIC is 
operational.

Uninitialized.
The firmware has not uploaded to the DeviceMaster. 
If this message is displayed in the History file, it 
often means that the DeviceMaster is in the process 
of being rebooted.

Device Status Message Description
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NS-Link Driver Troubleshooting

This table includes some tips related to NS-Link drivers.

NS-Link Condition Explanation/Action

Need to program IP 
address into the device.

Before programming an IP address it is critical that the 
DeviceMaster be operational and passes the power on tests 
when configured for the MAC address. 
Note: If the DeviceMaster is NOT operational, do NOT attempt 

to program or use an IP address with the DeviceMaster.
See Program the IP Address (Network Information) on Page 13 
for more information.

Cannot open port

1. Verify that MAC address in the NS-Link driver matches 
the address on the DeviceMaster.

2. Verify that you are using the correct NS-Link driver. If 
necessary, remove and reinstall a new driver.

3. Isolate the DeviceMaster from the network (see Page 67).
4. Check to see if another program or computer is active on 

this port.

The Comtrol device has a 
lower limitation of 
network bandwidth 
requirement of 64 Kbps. 

At this speed the entire available bandwidth is required for the 
purpose of uploading the firmware from the driver to the 
DeviceMaster. At lower speeds, timing issues will prevent the 
firmware from being successfully installed to the 
DeviceMaster, thus preventing the DeviceMaster from normal 
operation.
When using the DeviceMaster over a WAN link that is less 
than the recommended 64 Kbps, a timing modification may be 
made that will allow uploading of the firmware.
Load the driver locally to the DeviceMaster for the purpose of 
getting the firmware installed. The PC on the other side of the 
slow link can then “share” the port. The sharing may be 
exclusive as the firmware loader PC may not need to access the 
ports.
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Using Port Monitor to Test Ports

This procedure will check whether the DeviceMaster can:
• Communicate through the NS-Link device driver 
• Determine if a port is open with an application
If necessary, install PortVision DX (Before Installing the Comtrol Drivers 
Management Console on Page 9, Page 11).
1. Open PortVision DX using the desktop shortcut.
2. Start Port Monitor by clicking Tools > Applications > Port Monitor (PMon2).

3. Click Add Ports using the icon or Tools > Add Ports, 
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4. Click Driver, RPSHSI/NSLINK, and click Ok.

5. If the DeviceMaster is communicating with the device driver for Windows, 
Port Monitor should display CLOSED status. If a port is open for an 
application, it displays as OPEN, and displays Actual Throughput, TxTotal and 
RxTotal statistics. 

Normally, there should be no data errors recorded or they should be very 
small. To find out what the actual errors are, scroll to the right. You will see 
three columns: Overrun Errors, Framing Errors, and Parity Errors.
If the errors are:
• Overrun Errors represent receive buffer overflow errors. If this is the case, 

you will have to configure either software or hardware handshaking to 
control the flow of data. The most common errors are Overrun errors.

• Framing Errors indicate that there is an synchronization error between the 
beginning of a data frame and the end of the data frame. A frame usually 
consists of a start bit, 8 data bits, and a stop bit or two. The framing error 
occurs if the stop bit is not detected or it occurs in the wrong time frame. 
Most causes for framing errors are electrical noise on the data lines, or 
differences in the data clocks of the DeviceMaster and the connected device.

• Parity Errors occur when parity is used and the parity bit is not what is 
expected. This can also be caused by noise on the data lines.
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6. You can view additional statistics to Port Monitor by adding columns. Click 
Tools and Add Columns.

7. Highlight or shift-click to add multiple statistics and click Ok.

Note: See the Port Monitor help system if you need an explanation of a 
column.

8. Scroll to the right to view the new columns. 

9. If you want to capture this session, you can save a current session as a report. 
To do this, select one of the following save options:
• File > Save As 
• File > Save - if the report already exists in an older format

• Save Active Session  button

Reports can be opened, viewed and re-used when needed. To open and view a 
report: 
a. Select File > Open or the Open Existing Session  button. The Open 
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Session dialog appears.
b. Locate the session (table), you want to open and click the Open button.
Optionally, if you want to continue monitoring for an existing session, you 
need to activate the Polling Interval. 
• Select Tools > Settings to access the PMon2 Settings dialog
• Change the Polling Interval field to a value other than zero (0)

10. Leave Port Monitor open so that you can review events when using Test 
Terminal to test a port or ports.

Using Test Terminal

Test Terminal (WCom2) allows you to open a port, send characters and commands 
to the port, and toggle the control signals. This application can be used to 
troubleshoot communications on a port-by-port basis. 
• Send and Receive Test Data: This sends data out the transmit line to the 

loopback plug, which has the transmit and receive pins connected thus 
sending the data back through the Rx line to Test Terminal, which then 
displays the received data in the terminal window for that port. This test is 
only testing the Tx and Rx signal lines and nothing else. This test works in 
either RS-232 or RS-422 modes as both modes have transmit and receive 
capability. A failure in this test will essentially prevent the port from working 
in any manner.

• Loopback Test: This tests all of the modem control signals such as RTS, DTR, 
CTS, DSR, CD, and RI along with the Tx and Rx signals. When a signal is 
made HI in one line the corresponding signal line indicates this. The Loopback 
Test changes the state of the lines and looks for the corresponding state 
change. If it successfully recognizes all of these changes, the port passes. 
A failure on this test is not necessarily critical as it will depend on what is 
connected and how many signal lines are in use. For example, if you are using 
RS-232 in 3-wire mode (Transmit, Receive and Ground) a failure will cause no 
discernible issue since the other signals are not being used. If the port is 
configured for use as either RS-422 or RS-485 this test will fail and is expected 
to fail since RS-422 and RS-485 do not have the modem control signals that 
are present in RS-232 for which this test is designed.

The following procedures require a loopback plug to be placed on the port or ports 
that you want to test. A loopback plug was shipped with your DeviceMaster. If you 
need to build a replacement or additional loopback plugs, refer to the 
DeviceMaster Installation and Configuration Guide (Page 7), if you need to build 
loopback plugs.

Opening Ports The following procedure shows how to use Test Terminal to send and receive test 
data to the serial ports. If necessary, install PortVision DX (Page 11).
1. Stop all applications that may be accessing the ports such as RRAS or any 

faxing, or production software. See the appropriate help systems or manuals 
for instructions on stopping these services or applications. 
If another application is controlling the port, then Test Terminal will be unable 
to open the port and an error message will be shown.

2. Open PortVision DX using the desktop shortcut.
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3. Start Test Terminal (WCom2) by clicking Tools > Applications > Test Terminal 
(WCom2).

4. Select File > Open Port, the 
appropriate port (or ports) 
from the Open Ports drop-
down list and Ok.
Note: If you left Port Monitor 

open from the previous 
subsection, you should 
show that the port is 
open.

Go to the next procedure to send 
and receive test data. Use the 
appropriate procedure:
• Sending and Receiving Test 

Data (RS-232/422 and RS-
485: 4-Wire) on Page 82

• Sending and Receiving Data 
(RS-485: 2-Wire) on Page 84

Sending and 
Receiving Test Data 
(RS-232/422 and RS-
485: 4-Wire)

You can use this procedure to send and receive test data through the RS-232/422/
485 (4-wire, full-duplex) port or ports that you want to test.
1. If you have not done so, perform Steps 1 through 3 on Page 81.
2. Install the loopback plug onto the port (or ports) that you want to test.

See the DeviceMaster Installation and Configuration Guide that you can 
download on Page 7, if you need to build loopback plugs.

3. Select Port > Send and Receive Test Data.
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You should see the 
alphabet scrolling 
across the port. If so, 
then the port installed 
properly and is 
operational. 
Note: If you left Port 

Monitor 
running, it 
should show 
data sent and 
received and 
show the 
average data 
throughput on 
the port.

4. Select Port > Send and 
Receive Test Data to stop 
the scrolling data.

5. You can go to the next 
procedure to run the Loopback Test on Page 83 if this is an RS-232 port.

If this test successfully completed, then the port is operational as expected.
Note: Do NOT forget to restart the communications application.

Loopback Test (RS-
232)

The Loopback Test tests the modem control (hardware handshaking) signals. It 
only has meaning in RS-232 mode on serial connector interfaces with full RS-232 
signals. If performed under the following conditions, the test will always fail 
because full modem control signals are not present:
• RS-422
• RS-485
• RJ11 connectors
Use the following steps to run the Loopback Test.
1. If necessary, start Test Terminal (Page 81, Steps 1 through  3).
2. Click Port > Loopback Test.

This is a pass fail test and will take a second or two to complete. Repeat for 
each port that needs testing.

If the Loopback Test and the Send and Receive Test Data tests successfully 
complete, then the port is operational as expected.
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Sending and 
Receiving Data (RS-
485: 2-Wire)

This procedure shows how to use Test Terminal (WCom2) to test two RS-485 (2-
wire, half-duplex) ports.
1. Start Test Terminal.
2. Open two ports RS-485 ports. This example uses COM40 and COM41.

Test Terminal will open two windows, note that both ports show Receiving on 
the status bar.

3. Right-click both COM windows and remove the check mark for Receive.
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Both COM ports show Ready on the status bar.

4. Right-click in ONE window and select the Receive option from the pop up.
5. Right-click the OPPOSITE window and click Send.

The Status line shows Sending or Receiving.
In this case, COM40 is sending data and COM41 is receiving the data which is 
visually confirmed by the data scrolling across the COM41 window.
Note: If you do not see the data being received it MAY be necessary to also 

disable the RTS and DTR options from the right-click pop-up menu in 
each COM port.

6. Right-click and remove the check mark on the Sending COM port.
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7. Right-click and remove the check mark on the Receiving COM port.

Neither COM port is sending or receiving data but shows Ready on the Status 
bar.

8. Reverse the sending/receiving windows one at a time. Set the Receive option 
first, then in the opposite window, select the Send option.
The Status line shows Sending or Receiving in the reverse windows.

Data is now scrolling in the COM40 window. COM41 is static as it is not receiving 
data but transmitting data.

How Disable/Enable the Device Driver

Use the following procedure to disable or enable the device driver for a specific 
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DeviceMaster.
1. Right-click the DeviceMaster that you want to disable (or re-enable).
2. Click Disable (or Enable).

Technical Support

If you need technical support, contact Comtrol using one of the following methods.

Contact 
Method Corporate Headquarters

Downloads http://www.comtrol.com/Support

Web site  http://www.comtrol.com

Phone
763.957.6000
CST: 8AM-6PM (Monday through Friday, 
excluding major US holidays)
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Appendix A.  Configuring Non-Plug and 
Play Devices

After installing the hardware and driver for Windows operating systems, you can 
use this discussion to configure non-plug and play COM ports.

Installing Non-Plug and Play Devices

Use the following procedure to install non-plug and play devices.
1. If you have not so yet, connect the device to a DeviceMaster port and turn on 

the device.
2. Open the Control Panel.
3. Go to the appropriate subsection to install non-plug and play modems or 

printers:
• Installing Modems on Page 89
• Installing Printers on Page 90

Installing Modems Use the following procedure to install non-plug and play modems.
1. If you have not done so yet, connect the modem (or modems) to the desired 

DeviceMaster port (or ports) and turn on the modem (or modems).
Note: This may take a few minutes, depending upon your system and the 

number of modems you are installing.
2. Open the Control Panel and click the Phone and Modem Options icon.
3. Click the Modems tab.
4. Click Add.
5. Click Don’t detect my modem. I will select it from a list and then click Next.
6. Click an appropriate modem model and then click Next.

Note: If you have a driver from the modem manufacturer, click Have Disk and 
browse to the location of the driver. If your modem is not listed, go to the 
modem manufacturer’s web site and download the appropriate driver.

7. Highlight the port or ports on to which you have connected modems.
8. Click Finish to complete the modem installation.
9. Configure modem properties as necessary. For assistance, use the Windows 

help system.
To use this modem or modems with RRAS, you can refer to the Comtrol RRAS 
Configuration Overview for Windows XP document.
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Installing Printers Use the following procedure to install a non-plug and play printer.
Note: If you want to install a plug and play printer, connect the printer to the 

appropriate serial port and the driver should automatically install. If it 
does not automatically install, use the following procedure as a guide with 
the printer manufacturers documentation.

1. Open the Control Panel and click the Printers and Faxes icon.
2. Click Next when this screen appears.
3. Click the Local printer attached to this computer item.
4. Click the COM port that corresponds to the port to which the printer is 

connected.
5. Click the Manufacturer, Printer type, and then click Next. 

Note: If you have a driver from the printer manufacturer, click Have Disk and 
browse to the location of the driver. If your printer is not listed, go to the 
printer manufacturer’s web site and download the appropriate driver.

6. Optionally, enter a printer name and then click Next.
7. Click Yes if you want to print a test page.
8. Click Finish to complete the installation.
9. Close the Printer and Faxes Control Panel.
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